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1	 AUTHOR BIOGRAPHY

Shelley Fishel is the author of 8 other Microsoft Office books on www.bookboon.com

Shelley is an IT Trainer with 20 years’ experience of delivering Microsoft Office training 
both in the classroom and virtually. Shelley is a Microsoft Certified Trainer and holds 
certificates in both the design and facilitation of live online learning from the Learning 
and Performance Institute.

Shelley loves simplifying a process and enabling her students to get more done in less time.

You can also find Microsoft Office training on her new training portal at www.tomorrowsva.
com where you can access short sharp training on all topics Microsoft. 
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2	 WHAT IS ONENOTE

OneNote is a digital notebook. When you go to your meetings, you take with you a 
notebook. It may be ruled, have soft or hard covers, it could have plain paper or graph 
paper. Notebooks often divide into sections with section dividers so that you can keep 
different notes about different topics.

OneNote replicates all that and much more.

When attending meetings these day it is quite normal to take your laptop or tablet with 
you. Why lug around a laptop and a notebook when you can have your notebook ON 
your laptop. 

OneNote is integrated with Microsoft Office meaning that it talks to the other applications 
in the suite so that you can bring your emails into it, add meetings and notes and even 
insert tables, spreadsheets and much more.

In this book I will introduce you to working with OneNote – you will wonder how you 
ever managed without it!
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3	� WHAT FLAVOURS DOES 
ONENOTE COME IN?

3.1	 ONENOTE 2016

OneNote 2016 is the latest version of OneNote (at the time of writing). This is the version 
I will be using in this book.

3.2	 ONENOTE WEB

Office 365 comes with Web versions of each of the applications including OneNote.

3.3	 ONENOTE DESKTOP WINDOWS 10

When you purchase a laptop or desktop computer running Windows 10 it comes with a 
local version of OneNote that connects to a personal OneDrive – this is not in the scope 
of this book.

3.4	 ONENOTE DESKTOP MAC

There is also a version of OneNote for the Mac. 

3.5	 ONENOTE FOR IOS AND ANDROID

There are apps so that you can use OneNote on your iPad or Android tablet too. You can 
keep all your notes completely up to date.
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4	 WHAT ARE THE DIFFERENCES

When you open the different versions of OneNote you may well notice that the Ribbons 
have different options. For example, the desktop version has more functionality built in to 
it than the Web version or the Mac or iPad version. Each has functionality to suit where 
you are working.
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5	 THIS BOOK IS ABOUT

This book is about OneNote 2016 for the Windows desktop. You will find most of it useful 
for the other versions too although not everything will be available.
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6	 STARTING ONENOTE

You can start OneNote up in several ways.

•	 The Start Menu
•	 The Taskbar
•	 Desktop icon

6.1	 THE START MENU

Icons can be placed on the Start menu and the applications accessed from there.

Figure 1

6.2	 THE TASKBAR

Right click the icon on the Start menu and select More > Pin to Taskbar.
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Figure 2

6.3	 DESKTOP ICON

If you prefer to access your applications via a desktop icon, drag the icon from the Start 
menu to the desktop and a link will be created.

Figure 3
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7	 THE RIBBONS

As with all the Office 2016 applications OneNote 2016 also has a set of Ribbons. Here 
they are along with what they do.

7.1	 FILE RIBBON

Click the File shortcut and you will see the Backstage view open. Here you will find links 
to the settings that control OneNote, and this is also where you come to print and share.

Figure 4
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Item What it does

Info This is where you can see where your notebook is stored and get to synchronisation 

New Create a new notebook

Open Open an existing notebook

Print Decide what to print etc

Share Invite others to work with you in the notebook

Export Export the current page, section or the whole notebook to a variety of formats

Send Send the page by email, save as a pdf or post to a blog.

Account See your Microsoft Account details

Feedback Give feedback to Microsoft 

Options Control the way that OneNote works – various settings can be found here.

7.2	 HOME RIBBON

Figure 5

The Home Ribbon is where you will find regular formatting tools, Styles, Tags and a few 
extras including setting up Outlook Tasks, Emailing the page or adding meeting details to 
notes.

7.3	 THE INSERT RIBBON

Figure 6
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This is where you will find all the different things you can insert into your notebook. Such 
as: - tables, spreadsheets, attachments, video, audio and more.

7.4	 THE DRAW RIBBON

Figure 7

If you have a laptop/desktop with the ability to connect a digital pen, you can draw or 
write your notes. This ribbon is where you set up the pen colour, drawing or highlighting 
width and more drawing options.

7.5	 THE HISTORY RIBBON

Figure 8

Here you can see what has been happening in the notebook. Find work by authors and see 
any revisions made in the recent past.

7.6	 REVIEW RIBBON

Figure 9

Spelling, research and Accessibility all reside here.
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7.7	 VIEW RIBBON

Figure 10

This is where you can change what you are looking at or change the background colour of 
your pages. Zooming in and out is here too.
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8	� THE STRUCTURE OF 
A NOTEBOOK

OneNote notebooks are made up of Sections, and Pages. Each Notebook can be for a 
project, work area, or client to give you three examples. Then within the notebook you 
can divide the work into sections and each section can have as many pages as you need.

8.1	 SECTIONS

Sections appear at the top of the notebook. You can have as many sections as you need, 
and they can be colour coded as you wish.

To add a section, click the + at the end of the list of sections.

Figure 11

To colour code a section right click the section to change > choose Section Colour >Choose colour
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Figure 12

8.2	 ADD A SECTION

Click the + sign and then add a new section. 

8.3	 RENAME A SECTION

Right Click the section to rename and click Rename then type the name (1). Or double 
click the section heading to change and type the new name (2).
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Figure 13

8.4	 MOVE A SECTION

Click and drag the section to move and drop it where you want it to go within the same 
notebook.

Figure 14

Or right click the section to Move and choose Move or Copy then choose the location to 
move it to if you want to place it in another notebook.

Figure 15
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Figure 16

Choose where you want the 
section to go – it could be in 
another notebook or after a 
particluar section.

8.5	 MERGE SECTIONS

You may start working in a new section and then decide that it would be better off as part 
of another pre-existing section. In this case you can merge the sections. Right click the 
section to merge and choose Merge to another Section. Any pages in the section will be 
merged as well and will appear underneath existing pages in the section you merged into.

8.6	 PAGES

Sections are divided into Pages. Pages appear on the right-hand side of the screen. 

Download free eBooks at bookboon.com



ONENOTE 2016 The structure of a Notebook

25

Figure 17

8.7	 ADD A PAGE

Click the Plus sign on the right-hand side of the screen to add a page.

8.8	 RENAME A PAGE

Type the name of the page in the area for the title or right click the page title in the list 
and choose > rename.

8.9	 MOVE A PAGE

Right click the page in the page list on the right and choose Move or Copy then choose 
where to place it.
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Figure 18
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9	� WHERE TO STORE 
YOUR NOTEBOOK

Open OneNote for the first time and it opens with an empty notebook. This notebook is 
created in a folder called OneNote Notebooks which is stored in your Documents Folder. 
This is a locally stored notebook and is on your computer.

9.1	 OFFICE 365

If you are using OneNote as part of an Office 365 subscription, you may well want to have 
access to your notebook from any of your devices - your desktop, laptop, phone or tablet 
and even Windows or Mac both online and offline.

In order for your notebook to be available to you on all your devices and at any time, you 
will need to create it in your OneDrive for Business folder. 

I have a folder called Notebooks in my OneDrive for Business folder which is where I store 
my notebooks. This ensures that I can access these notebooks on any device at any time. It also 
means that if I want to share my notebook with someone else in my organisation it is simple.

9.2	 CREATE A NOTEBOOK

Click on the File Menu then click New and then choose the location to create your 
notebook in.
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Figure 19

New (1) choose location, you may have several OneDrive options choose the one you want 
(2) Pick the folder (3) Name and save (4)

You can also click Add Notebook on the drop down next to the name of the current 
notebook. 

Figure 20
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10	 OPEN A NOTEBOOK

10.1	 RECENTLY OPENED

If you have had a notebook open recently you will see it listed in OneNote on the drop-
down menu next to the name of the Notebook you have open. Select the one to open 
from the list.

Figure 21

10.2	 PIN THE NOTEBOOK PANE TO THE SIDE

Click the pin icon to pin the notebook pane to the left-hand side of the screen.
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Figure 22

If you are working with a few notebooks and need to move between the often this will 
make life easier.

10.3	 OPEN A NOTEBOOK FROM A FOLDER

1.	Click the File menu 
2.	Click Open
3.	Navigate to the location where the Notebook is stored
4.	Click the Notebook to open it.

10.4	 SECTION GROUPS

After working in a notebook for a while you may notice that you have too many sections 
to display across the top of the screen and it starts to become difficult to see what you are 
working on.

Section groups can help with organisation. Add all the sections to do with a topic to a 
Section Group and then you can expand and collapse them.
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10.5	 CREATE A SECTION GROUP

Right click where the sections are showing and choose New Section Group

Figure 23

The new Section Group is created. 

Figure 24

10.6	 RENAME THE SECTION GROUP

Right click on the New Section Group and select Rename then type a name for the group.
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10.7	 ADD SECTIONS WITHIN THE NEW SECTION GROUP

You can click on the New Section Group you just created and then click the + to add 
sections – just the same as creating a new section in the main part of the notebook. 
Equally you can move or copy existing sections into the new section group by following 
the instructions to Move a Section.

10.8	 DISPLAY THE CONTENT OF A SECTION GROUP

Click on the Section Group name (1) Add sections (2) Get back to the main part of the 
notebook (3)

Figure 25
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11	� ADDING CONTENT TO 
YOUR NOTEBOOK

Now that you know how to add Sections and Pages to your notebook and where to store 
it, it’s time to start adding content. Content comes in many forms from simple text to 
complex diagrams, handwritten or typed. The only limit to a notebook is your imagination.

11.1	 ADDING TEXT

11.1.1	TYPE ANYWHERE

With OneNote you just start typing wherever you happen to be, and your text will appear in 
a text box. The text box will grow to accommodate any text you add. You can segment your 
thoughts by clicking outside the current text box and starting a new one elsewhere on the 
page. A bit like jotting down notes on a page of paper – you can write or draw anywhere.
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Figure 26

11.2	 MOVE TEXT AROUND

When you have finished with the current musings you may want to rearrange the notes 
you just wrote. You can move the text boxes around by clicking on the grey bar at the top 
and when you see the four headed arrow, dragging it to a new location.

Figure 27

11.3	 CUT COPY AND PASTE TEXT

You can cut or copy text from one text box to another or from one page to another. When 
you cut or copy anything, OneNote places it on the clipboard until you paste it in the 
desired location.
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Use the Clipboard group of icons on the Home Ribbon to Cut Copy and Paste or use the 
Keyboard Shortcuts: 

•	 Control + C to Copy
•	 Control + X to Cut
•	 Control + V to paste

Figure 28

11.4	 PASTING FORMATTED TEXT

If the text you are pasting in has formatting applied, you will be given options. 

•	 Keep the source formatting – if it was blue keep it blue
•	 Merge formatting – change the format of the text so that it matches the text around it
•	 Keep text only – paste as plain text without adding any formatting
•	 Paste as a picture -inserts the text as an image

Figure 29
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11.5	 FORMATTING

11.5.1	FONT AND PARAGRAPH FORMATTING

When you start to type you will have the familiar formatting tools on the Home Ribbon. 
The Basic Text group and the Styles Group. You can use any of the regular formatting 
options – Bold, Italic, Underline, Superscript, Subscript, Strikethrough. 

Then you have the option of changing the font colour or highlighting the text and creating 
bulleted or numbered lists.

When you select text on the page, a mini toolbar will appear offering you formatting 
options in situ.

Figure 30

11.6	 STYLES

Just like in Microsoft Word you can use Heading Styles to differentiate between your 
headings and body text.

Find the Styles in the Styles Group and apply them as you need.
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Figure 31

11.7	 HANDWRITING AND DRAWING – OTHERWISE KNOWN AS INK

Depending on the device you are using, you may have the ability to draw or write on your 
screen with a digital pen or you may have to use your finger to write. If you do not have 
a touch screen device, you can use the mouse to draw or write.

11.8	 CHOOSE THE PEN

First you need to choose the pen including the ink colour and width. There is a large 
variety of ink styles and colours available. You can also choose the Pen Mode – create both 
Handwriting and Drawings – the default or to create Drawings only or Handwriting only. 
If you have a pen, then you can use the Pen as a pointer too. 
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Figure 32

11.9	 COLOUR AND THICKNESS

Click the Colour and Thickness icon to choose from more colours and the desired thickness 
of the lines you draw or write.
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Figure 33

11.10	 INK TO TEXT

When you use the mouse, your finger or your pen to write, you can use the Ink to text 
command to turn your handwriting into typed text.

Write your text (1) click Ink to Text (2) your handwriting changes to type (3)

Download free eBooks at bookboon.com



ONENOTE 2016 Adding Content to your Notebook

40

Figure 34

11.11	 INK TO MATH

You can add equations to your Notebook by typing into an equation box.

Click Ink to Math (1) write your equation in the box that appears (2) and (3) then press 
Insert (4) or enter and see the result typed up (5)
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Figure 35

11.12	 SELECT VIEW AND ERASE INK

When you want to move some ink or erase it first you will need to select it.

Click Lasso Select and then drag around the text to select. 

To move it click on the selected text and use the four headed arrow to drag to the new 
location.

Figure 36
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11.13	 TO DELETE INK

Select the text as above and then press delete on the keyboard or 

Click Erase on the Draw Ribbon and drag the mouse pointer, your finger or your digital 
pen over the text to delete it.

Figure 37

Lasso Select (1) Eraser (2) Choose which eraser to use (3) Change to typing (4)
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12	 BULLETS AND NUMBERING

12.1	 SIMPLE BULLETED OR NUMBERED LISTS

Notes are no different to regular documents and at times you will want to have bulleted or 
numbered lists. Just like in the other Office programs Bullets and Numbering are on the 
Home Ribbon and work in the same way.

To start a bulleted or numbered list click the icon and then start to type. Each time you 
press enter you will be given a new bullet. 

Figure 38

Bullets (1) Numbering (2)

12.2	 MULTI-LEVEL NUMBERING 

Multi-level numbering is used when you have different levels of numbering such as 

1.	Main number level
a.	 Sub level
b.	 Another sub level

2.	Main level again
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To create this type of numbering use the Tab key and the Shift Tab option.

1.	Start your first numbered item with the Numbering icon.
2.	Press enter to get to the next line and number
3.	Now press the tab key - the text will be indented, and a letter applied like the 

example above
4.	When you press enter you get the next sub level
5.	To move back to the main level- press shift and tab.

Continue to use the tab key to move in and the shift and tab keys to move back out until 
you have finished your list.

12.3	 STOP BULLETS OR NUMBERING

To stop bulleted or numbered lists, press the enter key twice.

12.4	 CREATE AND FORMAT SHAPES

Sometimes shapes are what is needed to illustrate a point, a diagram or a specific shape 
arrows can be helpful too. You can add both regular shapes or hand-drawn shapes to your 
notebook. Hand-drawn shapes can also be converted into regular shapes.

12.5	 USE THE SHAPES GROUP

To insert a regular shape, use the Shapes group. 

Figure 39

You will find the shapes options on the Draw Ribbon.

Choose the shape you want and drag it out on the page. 
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12.6	 LOCK DRAWING MODE

This keeps drawing mode on so that you can keep on drawing shapes. To turn it off press 
the Escape key or click the Type key on the Ribbon.

12.7	 FORMAT SHAPES

If you would like your shapes to be drawn in colour, choose the pen first. Choose both 
the thickness and the colour. Then head over to the Shapes gallery and pick the shape to 
draw. It will be drawn using the pen and colour you chose. 

12.8	 ARRANGE

Using the Arrange menu, you can choose to send shapes backwards or forwards in the 
order. If you draw shapes on top of each other, you decide which is at the front and which 
at the back.

I have drawn three shapes and chosen to send the rectangle to the back. It is behind the 
other two shapes.

Figure 40
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12.9	 INSERT A SPACE

Insert space around your drawings. 

Click on the Insert Space Icon 

Drag in a downward direction on the page to create the space you need.

Figure 41

12.10	 ROTATE SHAPES

1.	Click on the shape to select it
2.	Click on Rotate and select the number of degrees or choose to flip it.
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Figure 42
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13	 ADDING IMAGES

13.1	 INSERT PICTURES

Just like in Word or PowerPoint you can add pictures to your notebooks.

On the Insert Ribbon (1) click Pictures (2)

Figure 43

Choose the picture to insert and click Insert. 

13.2	 RESIZE A PICTURE

Grab one of the square boxes around the image, click and drag. It will keep the aspect ratio 
if you drag from a corner.
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13.3	 FORMAT A PICTURE 

Figure 44

Right click on the image and choose from the options available.

Order (1) send backwards or forwards 

Rotate (2) choose to rotate or flip the image

Restore to original size (3) if you have resized it you can reset it

Set Picture as background (4) turn the picture into the background of the page

Alt Text (5) add alternative text – used for screen readers and SEO

Make Text in Image Searchable (6)
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13.4	 INSERT ONLINE PICTURES

If the image you want to use is from an online source, use the Online Pictures option.

Figure 45

•	 Choose where to look for your pictures – Bing or OneDrive (1)
•	 Type a keyword to find a picture (2)
•	 Choose one of the provided keywords (3)
•	 Make sure you respect copywrite (4)
•	 Click Insert when you have made your selection (5)

13.5	 SCREEN CLIPPINGS

When illustrating a process that is happening on screen it is useful to be able to add a 
screen clipping to show the full screen or just a selection.

1.	Have the window, website or program that you would like to clip from open
2.	Click on Screen Clipping
3.	OneNote will switch to the other program
4.	Click and drag over the region you want to clip
5.	The clipping is added to the note you are in along with a date and time stamp.
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Figure 46
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14	� ADDING MORE DATA TO 
YOUR NOTEBOOK

14.1	 QUICK NOTES

Quick Note are notes that you can make on the fly. They will be added to a section called 
Quick Notes. By default, the Quick Notes will appear in whichever Notebook was set up 
first. This can be changed in Options. 

14.2	 CHANGE THE LOCATION FOR QUICK NOTES

1.	Click File
2.	Click Options
3.	Click Save and Backup

Figure 47
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Save and Backup (1) Click Modify (2) choose the location in the notebook you want to 
use (3) Click Select (4) click OK when done (5)

The new location is now set, and any Quick Notes will be placed there.

14.3	 ADD A QUICK NOTE 

You will find the shortcut for Quick Notes in the System Tray at the bottom right of your 
screen. You may need to click the up arrow to see it.

Figure 48

Click the Quick Note Icon

Type your note in the floating window

Figure 49
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Quick Notes now appear in the Notebook you specified

Figure 50

14.4	 TABLES

Tables can be added to Notebook pages by typing and using the tab key or by inserting a 
table as you do in Word. 

14.5	 USE THE TAB KEY

Type your first column heading press tab and then type the next column heading carry on 
pressing tab to get a new column until you have all the columns you need. Now press the 
Enter key to get a new row. Use the tab key to move between the columns and when you 
get to the end of the last row, the tab key will move you down to the next row.

14.6	 USE THE INSERT TABLE ICON

1.	Click the Insert Ribbon
2.	Click the drop down under the Table Icon
3.	Drag over the number of columns you need
4.	Type your headings – when you get to the last cell on the top row, if you press 

tab you will get another column 
5.	Press Enter to get to the first row
6.	Continue to use the tab key to move between columns and type in your content
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14.7	 THE TABLE TOOLS RIBBON

Just like Word, when you are in a table in OneNote you will see the Table Tools Ribbon

Figure 51

Use the icons on the Ribbon to add rows and columns or delete rows and columns. You 
can also add shading and borders and set alignment along with Sorting the contents. You 
can also convert the table to an Excel Spreadsheet.

14.8	 CONVERT A TABLE TO AN EXCEL SPREADSHEET 

When you have added your table and some content select the table (not the placeholder) 
and then click Convert to Excel Spreadsheet.

Figure 52

Download free eBooks at bookboon.com



ONENOTE 2016 Adding more data to your notebook

56

It will take a moment or two to process and then you will see a spreadsheet on the page. 

Figure 53

To edit the spreadsheet, click on the little edit button top left. It will then open in Excel 
where you can make any changes. When done close the Excel file and choose Save changes. 

When you are back in OneNote you will not see the changes you just made until you refresh 
the spreadsheet connection. To do this right click on the spreadsheet and select Refresh.

Figure 54
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Figure 55

Figure 56
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14.9	 ATTACH FILES AND PRINTOUTS

An attachment inserts a link to the original file into the Notebook. A printout inserts a 
picture of the contents of the file into the Notebook. 

Inserting a file as a printout places a picture of its contents on a page in OneNote. You can’t 
edit printouts like regular notes, so they’re a good choice if you want to keep the original 
formatting. The inserted printouts work just like inserted pictures. You can resize them and 
move them anywhere on the page. You can add notes or annotations to the image. 

14.10	 INSERT A FILE PRINTOUT

On the Insert Ribbon click File Printout and then navigate to the file you wish to insert 
and click Insert.

Figure 57

You will see the content of the file added to the Notebook with a link above it.

In this example I added a PowerPoint presentation to the Notebook.
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Figure 58

14.11	 EXTRACT TEXT FROM A FILE PRINTOUT

You can extract text from a file printout and paste it in your notes. This is useful if you 
want to make changes to the text or if you want to copy any part of the text into an email 
or other file, like a Word document.

Right-click the image, and then do one of the following:

•	 Click Copy Text from this Page of the Printout to copy text from only the currently 
selected image (page).
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•	 Click Copy Text from All the Pages of the Printout to copy text from all the 
images (pages).

•	 Click where you’d like to paste the copied text, and then press CTR + V

14.12	 INSERT FILE ATTACHMENT

A copy of the file is inserted on the current page and shown as an icon that you can open.

Attached files are stored as part of their associated notebook. If you move a notebook to 
another location, any inserted files move with the notebook.

Remember if you make any changes to the file you open from the link, they are not saved 
with the file and if you update the original the changes will not show up in OneNote.

1.	Click the File Attachment icon

Figure 59

2.	Navigate to the file you wish to link to
3.	Click Insert
4.	You will see a dialogue box asking if you want an attachment or a printout

Figure 60
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5.	Choose Attach File
6.	A link will be added to the Notebook

Figure 61

To open the files simply double click the file icon. You will see a warning to only open 
trusted attachments. Click OK and the file will open.
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The attachment function is really useful if you are going to a meeting and want to have 
several documents ready to show someone. By adding the links to your notes, you have 
everything to hand.

14.13	 HYPERLINKS

Hyperlinks can be added to notes and can link to a file location a website or location in 
another notebook.

Figure 62

14.14	 LINK TO A WEBSITE

Do one of the following:

•	 Click the page where you would like the link to appear 
•	 Select the text to be turned into a Hyperlink

Select the item to attach the link to On the Insert tab click on the Link icon
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In the dialogue box that appears, do one of the following:

•	 Enter the address of the web location to visit in the Address bar
•	 Click the Browse button to navigate to the website to use and copy its web address 

to the address box

Click OK

14.15	 LINK TO A FILE

Do one of the following:

•	 Click the page where you would like the link to appear 
•	 Select the text to be turned into a Hyperlink
•	 Select the item to attach the link to

On the Insert tab click on the Link icon

Edit the contents of the Text to Display to show the text you want to show on the page.

Click Browse for a file and select the file you want to link to.

Click OK.

14.16	 LINK TO A LOCATION IN ONENOTE

Follow the same steps as above and then in the - Or pick a location in OneNote – identify 
the location you want to link to.

Click OK.

14.17	� CREATE LINKS TO NOTEBOOKS, SECTIONS, 
PAGES, AND PARAGRAPHS

It’s easy to create a quick table of contents to other areas in your notes. You can create links 
to notebooks, sections, pages, and even specific paragraphs.
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14.18	 COPY AND PASTE A LINK TO A NOTEBOOK

1.	Right-click the notebook name that the link should point to.
2.	On the shortcut menu, click Copy Link to Notebook.

The link to the selected notebook and the title of the notebook are copied to the Clipboard.

3.	Click the location on the page that is to contain the link.
4.	On the Home Ribbon in the clipboard group click the drop-down arrow and click 

the paste option to keep source formatting.

OneNote inserts a link that, when clicked, displays the target notebook.

14.19	 COPY AND PASTE A LINK TO A SECTION

1.	Right-click the tab of the section that the link should point to.
2.	On the shortcut menu, click Copy Link to Section.

The link to the selected section and the title of the section are copied to the Clipboard.

3.	Click the location on the page that is to contain the link.
4.	On the Home Ribbon in the clipboard group, click the drop-down arrow and click 

the paste option to keep source formatting.

OneNote inserts a link that, when clicked, displays the target section.

14.20	 COPY AND PASTE A LINK TO A PAGE

1.	 In the side margin, right-click the tab of the page that the link should point to.
2.	On the shortcut menu, click Copy Link to Page.

The link to the selected page and the title of the page are copied to the Clipboard.

3.	Click the location on the page that is to contain the link.
4.	On the Home Ribbon in the clipboard group, click the drop-down arrow and click 

the paste option to keep source formatting.

OneNote inserts a link that, when clicked, displays the target page.
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14.21	 COPY AND PASTE A LINK TO A PARAGRAPH

1.	Move your cursor to the left edge of the paragraph you want to link.
2.	Right-click the four-headed arrow next to the paragraph the link should point to.
3.	On the shortcut menu, click Copy Link to Paragraph.

The link to the selected paragraph and the paragraph text are copied to the Clipboard.

4.	Click the location on the page that is to contain the link.
5.	On the Home Ribbon in the clipboard group click the drop-down arrow and click 

the paste option to keep source formatting

14.22	 TO GET BACK TO THE PREVIOUS LOCATION

Click the back arrow on the Quick Access Toolbar

Figure 63

Download free eBooks at bookboon.com



ONENOTE 2016 Record audio and video

66

15	 RECORD AUDIO AND VIDEO

Adding Audio and Video to your notes is a handy addition. Record a conversation or a 
meeting to transcribe later or capture video of a meeting to review later.

15.1	 RECORD AUDIO

Click on the page where you wish the audio recording to appear. On the Insert Ribbon, 
click Record Audio.

Figure 64

The recording will start. Start to speak and anything you say will be recorded. You can also 
record anything in the vicinity, so you could place your computer on a desk in a meeting 
and record the audio of the meeting.

You will see the recording Ribbon and an audio shortcut on the page.

Figure 65
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Audio Icon on the page (1) Playback Ribbon (2) Stop and Pause Buttons (3) 

15.2	 PLAYBACK YOUR AUDIO RECORDING 

Double click on the Audio icon – (1) the recording will start to play. To fast forward by 
10 seconds or 10 minutes click on the Fast Forward button required (4).

15.3	 RECORD VIDEO

Similar to recording Audio you can also record video in your Notebook.

Click the Record Video button on the Insert Ribbon - a small video window will appear 
recording anything your rear camera can see. It will continue to record until you click Stop 
Recording.

Figure 66

15.4	 TO PLAY BACK YOUR VIDEO

Double click on the video icon on the page or click on See Playback on the Ribbon.
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16	 DATE AND TIME STAMPS

On the Insert Ribbon – click the required stamp.

Choose from:

•	 Date
•	 Time
•	 Date and Time

The stamps will appear on the page.

Figure 67

16.1	 ADDING SYMBOLS AND EQUATIONS

16.2.1	ADDING SYMBOLS

Symbols can be added throughout Microsoft Office and OneNote is no exception. 
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On the Insert Ribbon click the Symbols Icon.

Figure 68

Click More Symbols at the bottom to get to the Symbols dialogue box where you can 
choose from a wide variety of font sets and symbols. 

Figure 69
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16.2.2	ADDING EQUATIONS

On the Insert Ribbon click Equations and pick one from the drop-down list or choose 
Insert New Equation.

Figure 70
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When you choose Insert New Equation, you will see the Equation Tools Design Ribbon 
and a placeholder to type the equation in.

Figure 71

Use the tools on the Ribbon to build your equation.
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17	 TAGS

Tags are used in OneNote to help you identify different types of notes. They can be used 
to turn checkbox lists in to Outlook Tasks or to highlight and categorise different types 
of notes. When you take lots of notes and just type anywhere on the page, it can get 
confusing and you can lose sight of important notes on topics or projects. Use Tags to 
help you identify your notes.

17.1	 TO DO CHECK BOXES

One of my favourite tags is the humble To Do although it is not really very humble as it 
can be used in a couple of ways.

When you have a list of tasks to complete, you can create a To Do list with handy tick 
boxes that can be checked off when the task is done. 

Not only that but these kind of checkbox tags help OneNote turn them into Outlook Tasks 
where you can also make them show up on your calendar.

17.2	 ADD A CHECKBOX TAG

•	 Type your list and then select it, click the To Do Tag
•	 Alternatively click the To Do Tag and then start to build your list (1)
•	 Each time you press enter you will have another task in your list. (2)

Figure 72
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17.3	 TURN YOUR LIST INTO OUTLOOK TASK

1.	Click on the item in the list to turn into an Outlook Task
2.	Click the Outlook task icon

Figure 73

Click on the date option required and a flag appears next to the item in the list

Figure 74

17.4	 TO SEE YOUR TASKS IN OUTLOOK 

Open Outlook and navigate to the Tasks section
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Figure 75

Your task will appear on the To Do List. 

17.5	 TO SEE YOUR TASKS ON THE CALENDAR

•	 Open the Calendar in Outlook 
•	 Make sure you are in Day, Week or Work Week View 
•	 Navigate to the View Ribbon
•	 Click on Show Daily Task Pane

You will now see your tasks at the bottom of the calendar view

Figure 76
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17.6	 USING TAGS TO CATEGORISE YOUR NOTES

As mentioned earlier you can use Tags to categorise your notes. This makes it easy to find 
all notes in a particular category and to summarise them too.

Click the drop-down list in the Tag Gallery and choose from a selection of ready-made 
tags. You can also modify these Tags and create your own.

Figure 77
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17.7	 COMMONLY USED TAGS

The most commonly used Tags have keyboard shortcuts that can be used to speed things up.

Tag Description  Keyboard Shortcut

To Do
Assign a task with 

a check box
Ctrl +1

Important Mark as Important Ctrl +2

Question
Remind yourself it’s a 
question to be asked

Ctrl +3

Remember for Later
Highlight in yellow to remind 

you to look at this later
Ctrl +4

Definition
Highlight in green – 

means it’s a definition
Ctrl +5

Contact Mark as Contact Information Ctrl +6

Address Mark as an address Ctrl +7

Phone Number Mark as a phone number Ctrl +8

17.8	 TAGS FOR RESEARCH

Tag Description

Web site to visit
Note a website of interest so 

you can find it later

Idea Mark up your ideas so they don’t get lost

Password 

Identify as a password -however don’t 
leave passwords in an unprotected 
notebook that could be accessed! 
Store your passwords elsewhere!

Critical Mark as really important information

Movie to see List a movie of interest 

Music to listen to
Note a song, album, or artist that 

you want to remember

Source for article Bibliographical reference

Remember for blog Ideas for blog posts 
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17.9	 PROJECT COMMUNICATION AND DELIVERY TAGS

Tag Description

Discuss with <Person A> Tag to discuss with person A

Discuss with <Person B> Tag to discuss with person B

Discuss with manager Tag to talk to your manager about this

Project A Related to a particular project

Project B Related to a different project

Send in email
Tag a request to email 

information to a colleague

Schedule meeting Tag a reminder to schedule a meeting

Call back Tag to call back

To Do Priority 1 High priority to do item

To Do Priority 2 Lower priority to do item

Client Request Mark an item as a client request

17.10	 MODIFY A TAG

You can create your own tags to use in a way that is meaningful to you. If you think that 
you are going to significantly modify one of the built-in tags, you may well be better off 
creating a brand new one. 

Figure 78
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17.11	� CLICK ON CUSTOMIZE TAGS AT THE 
BOTTOM OF THE TAG GALLERY (1)

Select the Tag to modify (2) Click on Modify Tag (3) Change the settings – such as name, 
symbol, font or highlight colour (4) Click OK when done (5).

See the modified tag in the list. 

Figure 79

17.12	 CREATE A TAG

Follow the steps to modify a Tag, however this time click New Tag in the dialogue box. 

Figure 80

Name the Tag (1) Choose a Symbol (2) Choose a font colour (3) Choose highlight colour 
if you want one (4) when your Tag looks how you want it click OK (5)
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17.13	 SEARCH BY TAG

When you are making lots of notes, be they personal notes, meeting notes or research notes, 
your notebook will fill up and you may not be able to find the notes you are looking for. 
In this case you can use the Tags to search for the notes you want to see.

To search for all notes with a specific Tag, click the Find Tags icon on the Home Ribbon

Figure 81

This opens the Tags Summary task pane where you can search for all tags or tags that have 
checkboxes that are unchecked.

17.14	� CHANGE WHERE TO SEARCH AND 
WHAT TO SEARCH FOR

Group tags by Name, Section, Title, Date or text. Select one tag to focus on, define where 
to search, this notebook or section or all notebooks. 
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Figure 82

17.15	 SUMMARISE TAGGED NOTES

As your notebooks become full of notes, taken from lots of meetings or musings, you may 
forget where notes are located or even a note that you took.

You can create a summary page of all the tags. This will create a new page with all the tags 
listed. These are copies of the tags that exist on the original pages, if you uncheck or check 
a box on the summary page, it will not change the original note.
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Figure 83
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18	� ADDING WEBPAGES 
TO ONENOTE

18.1	 DO YOUR RESEARCH 

When working on a project be it a work project or even booking a holiday, you may want 
or need to capture web pages. There are a couple of ways to get links to web pages into 
your notes.

18.2	 METHOD 1

Simply create a hyperlink to the page so that you can access it later. We covered Hyperlinks 
in the section Insert Hyperlink see: Link to a website on page 62

18.3	 METHOD 2

Use the OneNote Web Clipper extension for your preferred browser.

To Install the OneNote Web Clipper Extension type OneNote Web Clipper into your 
browser search and it will take you to the extension store for your browser. For example, 
in Chrome it takes you to the Chrome Extension Store and in Edge or Internet Explorer 
it will take you to the Microsoft Store. 

Follow the on-screen instructions to install the web clipper. 
Once it is installed here is how to use it.

Navigate to the page you want to capture and then click on the OneNote Web Clipper shortcut

Figure 84
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Sign in to your account – in this case a Work or School Account – you will be prompted 
for your email address and password.

Then choose what to clip

Figure 85

Full Page – this takes a snap shot of the page exactly as it is and pastes it into OneNote 
along with a hyperlink so that you can visit the page. Extremely useful if you are working 
with a designer on a website for example and want to make notes on the page for the 
designer showing them what you want.

Region – this allows you to select a region to copy and pastes it along with a hyperlink 
into your notebook.

Article – Makes the web page easier to read in your notebook. Also adds a hyperlink

Bookmark – this clips a bookmark and hyperlink to allow you to find it again.

On each occasion a new OneNote page is created with the name of the web page. 

Download free eBooks at bookboon.com



ONENOTE 2016 Adding Webpages to OneNote

84

Figure 86
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19	 ONENOTE AND OUTLOOK

For me one of the most useful features of OneNote is the integration with other Office 
applications and especially Outlook. We have already seen how to turn a To Do tag into 
an Outlook Task. Now we will meet some of the other integrations with Outlook.

19.1	 EMAIL

19.1.1	EMAIL A PAGE

You have been busy organising an event and you have a page full of notes that you want 
to share with a colleague. Simply email the page. Here is my page of notes about writing 
this book which I am going to email to myself.

1.	Type the notes
2.	Click Email Page on the Home Ribbon
3.	Address the new email that opens up
4.	Add any instructions
5.	Send!

Figure 87
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19.2	 SEND OUTLOOK EMAIL TO ONENOTE

If you go to meetings and need to discuss the content of several emails, it can be frustrating. 
You either spend valuable time going back and forth in Outlook whilst at the meeting trying 
to find the emails you want to discuss, or you print them off. 

Instead of wasting time or trees, send the emails to Outlook so that you have them all in 
one place.

1.	 In Outlook find the email you want to send to OneNote 
2.	Click the Send to OneNote icon

Figure 88

3.	Choose the Notebook and section

Figure 89

4.	Click OK
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The email now appears in the Notebook and location you specified

Figure 90

Continue to add emails to the Notebook until you have all the information to hand.

19.3	 CREATE OUTLOOK TASKS

Send a To Do tag to Outlook Tasks – see 73ge 48 for instructions.

19.4	 INSERT A MEETING

When attending a meeting, OneNote is particularly useful as you can take your own notes. 
When you have been invited to a meeting you can add the meeting to OneNote and it will 
bring a list of attendees and the time and dates and any notes. You can then take notes at 
the meeting and email the notes to all attendees.

1.	Click Meeting Details on the Home Ribbon
2.	Choose a meeting or Choose a Meeting from another day
3.	Select the meeting to insert
4.	Click Insert
5.	Your meeting details appear in OneNote
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Figure 91

19.4.1	TAKE MEETING NOTES

Once you have the meeting in OneNote you can type or write notes on the page where it 
says Notes. When you are done, you can email the page to the attendees. This time, when 
you click Email Page, it will set up a pre-populated email with everyone’s email address.
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Figure 92

19.5	 CREATE MEETING NOTES WHEN SETTING UP THE MEETING

When you set up a meeting you can create a meeting notebook to go with it. In the meeting 
request click the Meeting Notes button.

Figure 93

Choose whether to take notes on your own or to share notes with the meeting.

Figure 94
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Decide which notebook and section will host the meeting notes or create a new notebook.

Figure 95

A link to the online notebook will be placed in the meeting invitation.

Figure 96
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19.6	 VIEW AND TAKE MEETING NOTES

Here is the invite above received by Lisa Jones. I have opened it in Outlook on the Web. 

Figure 97

Note the link to the web notes.

Depending on your browser you may see a pop-up box asking if you want to open OneNote 
2016 or you may see an application launcher where you can pick which app to open. As 
I am using Microsoft Edge I get the option to open OneNote 2016

Figure 98

When I click yes it will open in OneNote 2016.

Figure 99

Download free eBooks at bookboon.com



ONENOTE 2016 OneNote and Outlook

92

The Notebook specified opens and there is a new page with the title of the meeting along 
with the attendees, time and date and an area designated for taking notes.

Simply type wherever you want to just like any other notes page.

19.7	 READ THE NOTES TAKEN

Whenever you open the notebook, you will see the notes taken. To differentiate between 
note takes, have each person add their initials or create tags for each person.
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20	 WORKING WITH EXCEL

20.1	 INSERT A SPREADSHEET

When working in OneNote you may want to add an Excel Spreadsheet. You can create a 
spreadsheet directly in your notebook or you can insert a ready-made one.

20.2	 INSERT AN EXCEL SPREADSHEET

On the Insert Ribbon click Spreadsheet and choose New Excel Spreadsheet

Figure 100

You now have a blank spreadsheet ready to use. 

Figure 101

Click the pencil icon top left corner to edit.
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Excel will open with full functionality. You can now enter any information you need.

Figure 102

Close the Excel spreadsheet – Save if prompted - and after a moment or so while the 
connections refresh you will see the data you entered in your Notebook spreadsheet. 

Figure 103

To edit the spreadsheet, click on it and when you see the pencil icon and the word Edit, 
click to edit.

This spreadsheet lives in the Notebook and to make changes you will need to be in the 
Notebook.
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20.3	 INSERT AN EXISTING SPREADSHEET

On the Insert Ribbon click on the Spreadsheet icon and choose Existing Excel spreadsheet.

When you insert an Existing Worksheet, OneNote creates a copy of the original that now 
lives in your Notebook. Any changes you make in the Notebook will not be available in 
the original and any changes you make to the original will not show up in the Notebook. 

Figure 104

Navigate to the folder that has your spreadsheet and select it. 

Figure 105
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Next choose what to insert:

Attach File – creates a copy of your Excel file and places an icon on the page so that you 
can access it whenever you need to. 

Insert Spreadsheet – This embeds a static copy of the spreadsheet along with an icon that 
opens the copy 

Insert Chart or Table – allows you to pick an element of the workbook to insert – again 
remember it is creating a copy!

In all instances, remember to keep the Excel Icon – do not delete it or you will not be able 
to edit the copy of your spreadsheet.

Figure 106

To include a single worksheet table or chart from a workbook, select Insert Chart or Table. 

Then pick which one to insert

Figure 107
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Here is what it looks like.

Figure 108

If you have opened the spreadsheet and made changes you can right click and select Refresh 
to make the changes appear in the Notebook.

Note that you can also choose Select What to Display - to change which worksheet is 
shown in your Notebook.

Download free eBooks at bookboon.com



ONENOTE 2016 Working with Excel

98

Figure 109

Remember – you are creating a copy of your spreadsheet in OneNote – any changes you 
make will not show in the Original.

Download free eBooks at bookboon.com



ONENOTE 2016 Page Design

99

21	 PAGE DESIGN

21.1	 CHANGE HOW THE PAGE LOOKS

When you first open a Notebook, it will have blank white pages with a space for the title 
of the page. You may not like clean and crisp blank page. White space may not be the best 
option for you to look at when working in your Notebook. You can change several elements 
of the page, its background colour whether it has ruled lines or not and even create your 
own page template. There is also a range of built in templates that you can choose to apply 
or to start from.

21.2	� CHANGE THE BACKGROUND COLOUR OF 
A PAGE AND ADD RULED LINES

Figure 110

Click the Page Colour icon to choose a different background colour and the Rule Lines 
Icon to choose which kind of lines you would like. If you are using OneNote on a touch 
screen device with a digital pen or stylus you may like to have lines to write on. 

Figure 111
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21.3	 HIDE PAGE TITLE

If you choose to Hide the Page Title, the page title will be deleted, and the page shows as 
untitled. Whatever you type at the top of the page becomes the title.

Figure 112

21.4	 USE BUILT IN TEMPLATES

OneNote comes equipped with a selection of templates to get you started. 

On the Insert Ribbon click Page Templates

A new task pane opens on the right of the page with templates grouped by theme. Click 
the arrow to expand a theme. Then click one of the links.
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Figure 113

A new page using the template you selected is now created.
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Figure 114

21.5	 SET THE DEFAULT TEMPLATE

You can choose a template and set it as your default. At the bottom of the task pane is the 
option to pick a template. Click here to select from a long list of options.
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Figure 115

New pages will now be based on the template you chose.

Figure 116

Set default template (1) click Add Page (2) New page based on the template chosen (3)
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21.6	 CREATE YOUR OWN TEMPLATE

If you have a preferred way of setting up your notes pages, you can create a template of 
your own.

Set the page up how you want it to look.

Figure 117

Then click Save Current Page as Template

Figure 118

You will be asked to name the template and to decide if it is the default template for the 
current section.
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Figure 119

It will now show in the new My Templates section that has appeared when you choose a 
template.

Figure 120
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22	 EXPORT TO OTHER FORMATS

Using OneNote to create notes is a great way to keep all your ideas in one place. However, 
there may be times where you want to send those ideas elsewhere. 

OneNote provides the functionality to export your notes to different formats so that you 
will find one that works for you.

Click the File menu and then Export.

Figure 121

Choose whether to export the current Page, a Section or the whole Notebook.

Then select the format.

Figure 122
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The formats will change based on which type of Export you selected in the first instance. 

OneNote 2010-2016 Section (*.one) - 

Word Document *(.docx)

Word 97-2003 Document (*.doc)

PDF (*.pdf )

XPS (*.xps)

Single File Web Page (*.mht)

If you choose to export a page – just the current page will be exported to the format you 
specify. If you choose Section – all pages in the section are exported and if you choose 
Notebook, then the whole Notebook is exported. 

If you change your mind when you export there is an option to change what you are 
exporting from the Export dialogue – click the circle you want.

Figure 123

22.1	 SEND NOTES TO COLLEAGUES

There are different ways to send notes to others. 

Click File and then Send.
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Figure 124

Make your choice.

Email Page – this sends the content of the current page in the body of an email, like 
clicking on the Email page icon.

Send as Attachment – this sends the current page as an attachment to an email so that you 
can open it with the full functionality of OneNote.

Send as PDF – creates a PDF and sends that as an Attachment.

Send to Word – copies the content of the page and pastes into a Word Document

Send to Blog – one of my favourites – sends the notes to a Word Blog document which 
means you can upload directly to your blog! I often write my blog posts in OneNote – I 
come up with a topic and away I go. This allows me to send it directly to the blog post 
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template which I have connected to my blog. I can then publish as a draft and all the text 
and images are uploaded. It saves loads of time.

Here is what a Blog Post looks like in Word – note the Ribbon which has publishing icons 
and the layout is like a web page.

Figure 125
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23	 LINKED NOTEBOOKS

23.1	 ADD NOTES WHEN WORKING IN OTHER APPS

It can be helpful to make notes when working in other applications such as Word, Excel, 
PowerPoint or on the web. You might want to remember why you did something or make 
a note to add something else later.

You can create Linked Notes starting from OneNote or from the application.

23.2	 TO START FROM ONENOTE

Open OneNote and create a page for the notes if you would like them to be on their own page

Then click the Review icon and select Linked Notes

Figure 126

Figure 127
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Pick the location for the Linked Notes and see the task pane that is now docked on the 
right-hand side of your screen. This is where you will type your notes.

Figure 128

To see your Linked Notes in OneNote, open the Notebook that stores them. You will see 
a small icon which shows that the notes came from a specific application

Figure 129

Hover over the icon and see information about the note.
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Figure 130

23.3	 TAKE LINKED NOTES FROM AN APPLICATION

1.	Start the application - in this case Word
2.	Navigate to the Review Ribbon and click on Linked Notes

Figure 131

The Linked Notes task pane will appear on the desktop and you can start taking notes.
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Figure 132

Linked Notes will be placed in the same Linked Notes page you specified earlier. To change 
where notes are placed, you need to display the Ribbon in the Linked Notes Task Pane.

23.4	 DISPLAY THE RIBBON IN LINKED NOTES

Click on the three dots at the top of the Linked Notes task pane (1) Display the Pages 
Ribbon (2) Click New Page (3) You now have a new page for your Linked Notes.

Figure 133
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23.5	 INFORMATION ABOUT LINKED NOTES

Figure 134

Click the Link icon at the top of the Linked Notes Task Pane and a drop-down list appears. 
Here you can see which files you have linked to, delete any links on this page, stop taking 
linked notes or get to Linked Notes Options.

Figure 135
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24	 SEARCH NOTEBOOKS

As you start to use OneNote 2016 more and more you may well forget where you put 
that important note. Was it on this page or that? Which Section or even which Notebook?

Search in OneNote is very good and allows you to set where you search. You can search 
for Tags as we saw in a previous section or you can search for text.

24.1	 SEARCH ALL NOTEBOOKS OR THE CURRENT PAGE

24.1.1	SEARCH ALL NOTEBOOKS

This is the default and when you click into the search box, OneNote searches all Notebooks 
for the text you enter. 

Figure 136
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Here I have searched for Excel – OneNote highlights where it appears, in Section titles or 
on pages. Click on the Result to jump to the page with the notes on.

24.2	 SEARCH CURRENT PAGE 

Press Control + F (Find) to search only the current page.
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25	 COLLABORATE WITH OTHERS

25.1	 SHARE USING ONEDRIVE OR SHAREPOINT

When you work in a team whether they are all sitting in your office or dispersed around 
the country or even the world, it is handy to have a one stop shop for all ideas or notes 
on a project. OneNote can help you do this. By storing your Notebooks in OneDrive or 
SharePoint you are all set to share and collaborate with others in a Notebook.

When you first create a Notebook, OneNote asks you if you wish to invite others. If you 
know at the outset, then add their email addresses at the point of creation. 

Figure 137

You can always share with others later once you have set the Notebook up how you want 
it to be used.

25.2	 CREATE A NOTEBOOK IN ONEDRIVE OR SHAREPOINT

When you click File then New or the Add Notebook shortcut at the top of the Notebook 
list, the first thing to decide is where to store the Notebook. This is where you choose 
OneDrive or SharePoint.
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Figure 138

Then go ahead and name the Notebook 

25.3	 SHARE A NOTEBOOK

1.	Click the File menu
2.	Click Share
3.	Click Share with People
4.	Type their email address and a personal message
5.	Decide if they can edit or just view
6.	Click Share
7.	When done you can see who the Notebook is shared with.
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Figure 139

25.4	 OPEN A SHARED NOTEBOOK

Lisa received a sharing invitation in Outlook with a link to the Notebook I shared with 
her. She can click the link to open the Notebook. In this instance it will open online as 
Lisa has opened Outlook online. 
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Figure 140

The Notebook opens in OneNote online. Lisa can bookmark the Notebook or click Open 
in OneNote to open with full OneNote functionality.

Figure 141

25.5	 SHARE WITH A MEETING

We saw in an earlier part of this book how to create Meeting Notes at the time of creating 
the meeting. This is where you allow everyone access to the Notebook to take their own notes.

It is often a challenge to take notes in a meeting and you can solicit everyone’s help and 
get them to take their own notes. Then all the notes are in the same place!

To share a notebook with participants of an online Skype for Business Meeting
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1.	Click File
2.	Click Share
3.	Click Share with Meeting 

Figure 142

Then select the meeting you want to share with – it will be a meeting that is in progress 
or you can start a new Skype for Business Meeting right here.

Figure 143

When you click OK the meeting notes are shared.
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26	 PRINTING

26.1	 PRINT AND PRINT PREVIEW

Before you print your Notes, you may want to see how they will look on paper. Start with 
Print Preview.

Figure 144

This will open a preview of the Notes. 

A Preview of the page opens in a window (1) you can choose what range to print (2) Set 
the paper size and scaling (3) Landscape or Portrait Orientation (4) Add extras like Page 
Numbers (5) See how many pages and move between them (6) Click OK or Print when 
done (7)
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Figure 145

26.2	 PRINT A NOTEBOOK

1.	Click File
2.	Click Print
3.	Choose the settings and click Print
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Figure 146
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27	 CUSTOMISE ONENOTE

As with all the Microsoft Applications, you can customise the app to work how it suits 
you. Things you may want to change are the Ribbon and Quick Access Toolbars adding or 
removing icons that you use frequently. You may want to customise how OneNote handles 
printing or which folder is the default for the creation of Notebooks.

27.1	 CUSTOMISE THE RIBBON AND QUICK ACCESS TOOLBAR

27.1.1	THE RIBBON

The Ribbon sits at the top of all Microsoft Office Applications. Each Ribbon has icons 
which perform tasks and Icons are grouped together. 

Figure 147

On the Home Ribbon displayed here, you can see the Clipboard Group, Basic Text Group, 
Styles Group, Tags Group, Email Group and Meetings Group. 

27.2	 TO ADD ICONS TO THE RIBBON

1.	Right Click an empty area on the Ribbon to customise 
2.	Select Customise the Ribbon

Figure 148
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Or

1.	Click File 
2.	Click Options
3.	Click Customise the Ribbon

In the Customise the Ribbon Options area 

Figure 149

1.	Start from Popular Commands however if the command you want is not visible 
you can change where to look here

2.	Choose the Command to add 
3.	Choose which of the Tabs to customise
4.	Click Add to make the command appear on the Ribbon Tab
5.	Create a New Tab, New Group or Rename a Ribbon Tab here
6.	Click Ok when you are done
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27.3	 THE QUICK ACCESS TOOLBAR

The Quick Access Toolbars is visible top left of the screen above the Ribbon and there is 
a Quick Access Toolbar in each Microsoft Application. Click the arrow on the far right of 
the Quick Access Toolbar to see the drop-down list. 

Figure 150

This list shows the icons that Microsoft think you may wish to add. To add one of them 
just click on it and it will appear and there will be a tick next to its name.

If you don’t see the icon you want, click More Commands and you will be taken to the 
Customise the Quick Access Toolbar section of OneNote Options.

OneNote Options opens at the Customise Quick Access Toolbar section.
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Figure 151

Add icons in the same way as they are added to the main Ribbons. They then appear on 
the Quick Access Toolbar. 

Figure 152

Here is the Email Page icon added to the Quick Access Toolbar.

27.4	 THE ALT KEY

Use the ALT key to see visual cues on screen for ways to use Keyboard Shortcuts. 
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Press the ALT key once to see numbers appear on the Quick Access Toolbar and Letters 
appear on the Ribbon tabs.

Figure 153

Press any letter to go to its associated Ribbon Tab. Then press the letters shown on the 
icons to activate the icon.

Press the number on the icons on the Quick Access Toolbar. For instance, if I press ALT 
+3 it will launch the Email Page icon. 

If I press N it will take me to the Insert Ribbon and then the letter F for File Attachment 

Figure 154

27.5	 SET PRINT OPTIONS 

1.	Click File 
2.	Click Options
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Figure 155

3.	Scroll down to the Printouts section and make your changes
4.	Click OK

27.6	 SAVE AND BACKUP OPTIONS

To change where OneNote saves new Notebooks by default:

1.	Click File
2.	Click Options
3.	Click Save and Backup
4.	Click the item to change in the Save section and then click Modify to choose the 

new location.
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Figure 156

27.7	 BACKUP NOTES

Hard drives do crash occasionally and if you want to make sure that you don’t lose your 
notes you should back them up just like any other file on your computer.

In the Backup section set the time interval for automatic backups and the number of backup 
copies to keep. The location is set in the Save section – Backup Folder and should be a 
location not on your hard drive, perhaps a network drive or a USB.

To backup manually click Backup Changed Files Now.
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27.8	 SYNC SETTINGS

OneNote automatically syncs any cloud connected notebooks to keep them up to date. If 
you turn this off, remember to sync regularly to avoid losing any of your work.

Download free eBooks at bookboon.com



ONENOTE 2016
KEYBOARD SHORTCUTS IN ONENOTE 

FOR WINDOWS – ONENOTE 2016

133

28	� KEYBOARD SHORTCUTS IN 
ONENOTE FOR WINDOWS – 
ONENOTE 2016

Notes: 

•	 The shortcuts in this topic refer to the US keyboard layout. Keys for other layouts 
might not correspond exactly to the keys on a US keyboard.

•	 Commands that require you to press and release multiple keys together are indicated 
with a plus sign (+). Commands that require you to press multiple keys in order 
are indicated by a comma sign (,).

28.1	 TAKING AND FORMATTING NOTES

28.1.1	TYPING AND EDITING NOTES

To do this Press 

Open a new OneNote window. Ctrl+M

Open a small OneNote window to create a side note. 
Ctrl+Shift+M or 
Windows+Alt+N

Dock the OneNote window. Ctrl+Alt+D

Undo the last action. Ctrl+Z

Redo the last action. Ctrl+Y

Select all items on the current page.
Note: Press Ctrl+A more than once to increase the scope of the selection.

Ctrl+A

Cut the selected text or item. Ctrl+X

Copy the selected text or item to the Clipboard. Ctrl+C

Paste the contents of the Clipboard. Ctrl+V

Move to the beginning of the line. Home

Move to the end of the line. End

Move one character to the left. Left Arrow
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Move one character to the right. Right Arrow

Move one word to the left. Ctrl+Left Arrow

Move one word to the right. Ctrl+Right Arrow

Delete one character to the left. Backspace

Delete one character to the right. Delete

Delete one word to the left. Ctrl+Backspace

Delete one word to the right. Ctrl+Delete

Insert a line break without starting a new paragraph. Shift+Enter

Check spelling. F7

Open the thesaurus for the currently selected word. Shift+F7

Bring up the context menu for any note, tab, or any other object that currently 
has focus.

Shift+F10

Execute the action suggested on the Information Bar if it appears at the top 
of a page.

Ctrl+Shift+W

28.2	 FORMATTING NOTES

To do this Press 

Highlight selected text. Ctrl+Shift+H or Ctrl+Alt+H

Insert a link. Ctrl+K

Copy the formatting of selected text (Format Painter). Ctrl+Shift+C

Paste the formatting to selected text (Format Painter). Ctrl+Shift+V

Open a link.
Note: The cursor must be placed anywhere within the formatted 
link text.

Enter

Apply or remove bold formatting from the selected text. Ctrl+B

Apply or remove italic formatting from the selected text. Ctrl+I

Apply or remove the underline from the selected text. Ctrl+U

Apply or remove strikethrough from the selected text. Ctrl+Hyphen
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Apply or remove superscript formatting from the selected text. Ctrl+Shift+=

Apply or remove subscript formatting from the selected text. Ctrl+=

Apply or remove bulleted list formatting from the selected 
paragraph.

Ctrl+Period

Apply or remove numbered list formatting from the selected 
paragraph.

Ctrl+Slash

Apply a Heading 1 style to the current note. Ctrl+Alt+1

Apply a Heading 2 style to the current note. Ctrl+Alt+2

Apply a Heading 3 style to the current note. Ctrl+Alt+3

Apply a Heading 4 style to the current note. Ctrl+Alt+4

Apply a Heading 5 style to the current note. Ctrl+Alt+5

Apply a Heading 6 style to the current note. Ctrl+Alt+6

Apply the Normal style to the current note. Ctrl+Shift+N

Indent a paragraph from the left. Alt+Shift+Right Arrow

Remove a paragraph indent from the left. Alt+Shift+Left Arrow

Right-align the selected paragraph. Ctrl+R

Left-align the selected paragraph. Ctrl+L

Increase the font size of selected text. Ctrl+Shift+>

Decrease the font size of selected text. Ctrl+Shift+<

Clear all formatting applied to the selected text. Ctrl+Shift+N

Show or hide rule lines on the current page. Ctrl+Shift+R

28.3	 ADDING ITEMS TO A PAGE

To do this Press 

Insert a document or file on the current page. Alt+N, F

Insert a document or file as a printout on the current page. Alt+N, O
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Show or hide document printouts on the current page (when running 
OneNote in High Contrast mode).

Alt+Shift+P

Insert a picture from a file. Alt+N, P

Insert a picture from a scanner or a camera. Alt+N, S

Insert a screen clipping.
Note: The OneNote icon must be active in the notification area, at 
the far right of the Windows taskbar.

Windows logo 
key+Shift+S

Insert the current date. Alt+Shift+D

Insert the current date and time. Alt+Shift+F

Insert the current time. Alt+Shift+T

Insert a line break. Shift+Enter

Start a math equation or convert selected text to a math equation. Alt+=

Insert a Euro (€) symbol. Ctrl+Alt+E

Create a table by adding a second column to already typed text. Tab

Create another column in a table with a single row. Tab

Create another row when at the end cell of a table.
Note: Press Enter a second time to finish the table.

Enter

Create a row below the current row in a table. Ctrl+Enter

Create another paragraph in the same cell in a table. Alt+Enter

Create a column to the right of the current column in a table. Ctrl+Alt+R

Create a row above the current one in a table (when the cursor is at 
the beginning of any row).

Enter

Delete the current empty row in a table (when the cursor is at the 
beginning of the row).

DEL (press twice)

28.4	 SELECTING NOTES AND OBJECTS

To do this Press 

Select all items on the current page.
Press Ctrl+A more than once to increase the scope of the selection.

Ctrl+A

Select to the end of the line. Shift+End
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Select the whole line (when the cursor is at the beginning of the line). Shift+Down Arrow

Jump to the title of the page and select it. Ctrl+Shift+T

Cancel the selected outline or page. Esc

Move the current paragraph or several selected paragraphs up. Alt+Shift+Up Arrow

Move the current paragraph or several selected paragraphs down. Alt+Shift+Down Arrow

Move the current paragraph or several selected paragraphs left 
(decreasing the indent).

Alt+Shift+Left Arrow

Move the current paragraph or several selected paragraphs right 
(increasing the indent).

Alt+Shift+Right Arrow

Select the current paragraph and its subordinate paragraphs. Ctrl+Shift+Hyphen

Delete the selected note or object. Delete

Move to the beginning of the line. Home

Move to the end of the line. End

Move one character to the left. Left Arrow

Move one character to the right. Right Arrow

Go back to the last page visited. Alt+Left Arrow

Go forward to the next page visited. Alt+Right Arrow

Start playback of a selected audio or video recording. Ctrl+Alt+P or Ctrl+Alt+S

Rewind the current audio or video recording by a few seconds. Ctrl+Alt+Y

Fast-forward the current audio or video recording by a few seconds. Ctrl+Alt+U

2.8.5	TAGGING NOTES

To do this Press 

Apply, mark, or clear the To Do tag. Ctrl+1

Apply or clear the Important tag. Ctrl+2

Apply or clear the Question tag. Ctrl+3

Apply or clear the Remember for later tag. Ctrl+4

Apply or clear the Definition tag. Ctrl+5
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Apply or clear a custom tag. Ctrl+6

Apply or clear a custom tag. Ctrl+7

Apply or clear a custom tag. Ctrl+8

Apply or clear a custom tag. Ctrl+9

Remove all note tags from the selected notes. Ctrl+0

28.6	 USING OUTLINES

To do this Press 

Show through Level 1. Alt+Shift+1

Expand to Level 2. Alt+Shift+2

Expand to Level 3. Alt+Shift+3

Expand to Level 4. Alt+Shift+4

Expand to Level 5. Alt+Shift+5

Expand to Level 6. Alt+Shift+6

Expand to Level 7. Alt+Shift+7

Expand to Level 8. Alt+Shift+8

Expand to Level 9. Alt+Shift+9

Expand all levels. Alt+Shift+0

Increase indent by one level. Tab

Decrease indent by one level. Shift+Tab

Expand a collapsed outline. Alt+Shift+Plus Sign

Collapse an expanded outline. Alt+Shift+Minus Sign

28.7	 SPECIFYING LANGUAGE SETTINGS

Note:  To change the writing direction for your notes, you must first enable right-to-left 
languages in the Microsoft Office Language Preferences tool.

To do this Press 

Set writing direction left to right. Ctrl+Left Shift

Set writing direction right to left. Ctrl+Right Shift
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Increase indent by one level in right-to-left text. Tab

Decrease indent by one level in right-to-left text. Shift+Tab

28.8	 WORKING WITH PAGES AND SIDE NOTES

To do this Press 

Enable or disable full page view. F11

Open a new OneNote window. Ctrl+M

Open a small OneNote window to create a side note. Ctrl+Shift+M

Expand or collapse the tabs of a page group. Ctrl+Shift+*

Print the current page. Ctrl+P

Add a new page at the end of the selected section. Ctrl+N

Increase the width of the page tabs bar. Ctrl+Shift+ [

Decrease the width of the page tabs bar. Ctrl+Shift+]

Create a new page below the current page tab at the same level. Ctrl+Alt+N

Decrease indent level of the current page tab label. Ctrl+Alt+ [

Increase indent level of the current page tab label. Ctrl+Alt+]

Create a new subpage below the current page. Ctrl+Shift+Alt+N

Select all items.
Press Ctrl+A several times to increase the scope of the selection.

Ctrl+A

Select the current page. Ctrl+Shift+A 
If the selected page is part of 
a group, press Ctrl+A to select 
all the pages in the group. 

Move the selected page tab up. Alt+Shift+Up Arrow

Move the selected page tab down. Alt+Shift+Down Arrow

Move the insertion point to the page title. Ctrl+Shift+T

Go to the first page in the currently visible set of page tabs. Alt+PAGE Up

Go to the last page in the currently visible set of page tabs. Alt+PAGE Down
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Scroll up in the current page. PAGE Up

Scroll down in the current page. PAGE Down

Scroll to the top of the current page. Ctrl+Home

Scroll to the bottom of the current page. Ctrl+End

Go to the next paragraph. Ctrl+Down Arrow

Go to the previous paragraph. Ctrl+Up Arrow

Go to the next note container. Alt+Down Arrow

Go to the beginning of the line. Home

Go to the end of the line. End

Move one character to the left. Left Arrow

Move one character to the right. Right Arrow

Go back to the last page visited. Alt+Left Arrow

Go forward to the next page visited. Alt+Right Arrow

Zoom in. Alt+Ctrl+Plus Sign (on 
the numeric keypad) or 
Alt+Ctrl+Shift+Plus Sign

Zoom out. Alt+Ctrl+Minus Sign (on 
the numeric keypad) or 
Alt+Ctrl+Shift+Hyphen 

Save changes.
Note: While OneNote is running, your notes are automatically 
saved whenever you change them. Manually saving notes is not 
necessary.

Ctrl+S

28.9	 WORKING WITH NOTEBOOKS AND SECTIONS

To do this Press 

Open OneNote. Windows+Shift+N

Open a notebook. Ctrl+O

Send to OneNote Tool Windows+N

Create a new section. Ctrl+T

Download free eBooks at bookboon.com



ONENOTE 2016
KEYBOARD SHORTCUTS IN ONENOTE 

FOR WINDOWS – ONENOTE 2016

141

Open a section. Ctrl+Alt+Shift+O

Go to the next section. Ctrl+Tab

Go to the previous section. Ctrl+Shift+Tab

Go to the next page in the section. Ctrl+PAGE Down

Go to the previous page in the section. Ctrl+PAGE Up

Go to the first page in the section. Alt+Home

Go to the last page in the section. Alt+End

Go to the first page in the currently visible 
set of page tabs.

Alt+PAGE Up

Go to the last page of the currently visible 
set of page tabs.

Alt+PAGE Down

Move or copy the current page. Ctrl+Alt+M

Put focus on the current page tab. Ctrl+Alt+G

Select the current page tab. Ctrl+SHFT+A

Put focus on the current section tab. Ctrl+Shift+G

Move the current section. Ctrl+Shift+G, and then Shift+F10, M

Switch to a different notebook on the 
Navigation bar.

Ctrl+G, then press Down Arrow or Up Arrow keys 
to select a different notebook, and then press 
Enter

28.10	 SEARCHING NOTES

To do this Press 

Move the insertion point to the Search box to search all notebooks. Ctrl+E

While searching all notebooks, preview the next result. Down Arrow

While searching all notebooks, go to the selected result and dismiss Search. Enter

Change the search scope. Ctrl+E, Tab, 
Space

Open the Search Results pane. Alt+O after 
searching
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Search only the current page.
Note: You can switch between searching everywhere and searching only the 
current page at any point by pressing Ctrl+E or Ctrl+F.

Ctrl+F

While searching the current page, move to the next result. Enter or F3

While searching the current page, move to the previous result. Shift+F3

Dismiss Search and return to the page. Esc

28.11	 SHARING NOTES WITH OTHER PEOPLE

To do this Press 

Send the selected pages in an e-mail message. Ctrl+Shift+E

28.12	 SHARING NOTES WITH OTHER PROGRAMS

To do this Press 

Send the selected pages in an e-mail message. Ctrl+Shift+E

Create a Today Outlook task from the currently selected note. Ctrl+Shift+1

Create a Tomorrow Outlook task from the currently selected note. Ctrl+Shift+2

Create a This Week Outlook task from the currently selected note. Ctrl+Shift+3

Create a Next Week Outlook task from the currently selected note. Ctrl+Shift+4

Create a No Date Outlook task from the currently selected note. Ctrl+Shift+5

Open the selected Outlook task. Ctrl+Shift+K 

Mark the selected Outlook task as complete. Ctrl+Shift+9

Delete the selected Outlook task. Ctrl+Shift+0

Sync changes in the current shared notebook. Shift+F9

Sync changes in all shared notebooks. F9

Mark the current page as Unread. Ctrl+Q
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28.13	 PASSWORD-PROTECTING SECTIONS

To do this Press 

Lock all password-protected sections. Ctrl+Alt+L
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